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Introduction 

The purpose of this LOOK User’s Guide is to give you, the reader, a quick and easy 
introduction to LOOK. 

About LOOK 
LOOK is developed by Symprex and is a comprehensive group calendar solution that can 
replace the built-in group calendar in Outlook. LOOK provides a number of features that 
can greatly enhance productivity and efficiency, and is more powerful and flexible than the 
built-in group calendar in Outlook. 

Features 
Some of the most important features of LOOK are: 
• Real-time group calendar overviews and very fast view updates with LOOK 

Enterprise Edition not possible with Outlook. Outlook relies on what is called 
free/busy information that has a latency of up to 15 minutes. 

• Enhanced views and additional view types offer better overviews and provide 
more functionality and details compared to Outlook. 

• Superior browsing and selection of users, groups and public calendar folders 
compared to Outlook. 

• Superior favorites features allow both personal favorites and adding existing 
groups to favorites compared to Outlook. 

• User-defined filters that can be applied to any view at any time makes it very 
easy to view for example work plans or holiday plans not available in Outlook. 

• Category color-coding of appointments greatly extends the few limited free/busy 
types and labels in Outlook. 

• Export of group calendars to HTML, Word, Excel and Clipboard not available 
in Outlook. 

• Print of group calendar views not available in Outlook. 
• Search across multiple calendars and advanced booking features not available 

in Outlook. 
• Find and resolve appointment conflicts not available in Outlook. 
• And more! 
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Requirements 
LOOK works with the following versions of Outlook, Exchange and Windows: 
• Microsoft Outlook 2000, 2002, 2003, 2007 and 2010 
• Microsoft Exchange 2000, 2003, 2007 and 2010 
• Microsoft Windows 2000, XP, Vista and 7 

LOOK also supports the following platforms: 
• Microsoft Terminal Services on Windows 2000, 2003 and 2008 
• Citrix MetaFrame on Windows 2000, 2003 and 2008 

LOOK hardware requirements are the same as for the version of Microsoft Office that 
LOOK is used with. A screen resolution of 800x600 or higher is recommended. 20 MB of 
hard disk space is required. 
 



 

 

1 
User’s Guide 

This chapter explains how to start LOOK and use its primary features with an introduction 
to the main window, explorer and calendar views, and how to navigate the application. 

Starting LOOK 
You can start LOOK from Outlook via the Outlook toolbar or Tools menu. Select LOOK, 
which appears as a button and menu with the label LOOK and the LOOK icon: 

 
You can also start the stand-alone version of LOOK in the Programs folder in the Windows 
Start menu. 
Once LOOK is running you can activate it pressing Ctrl+F12 from anywhere in Windows. 
You can change this hot key to another key combination in the Options dialog. 

LOOK Window Overview 
LOOK is a standard Windows application and is designed to be as easy to get started with 
as possible. The figure below shows what LOOK looks like. At the top, you find the usual 
menu bar and toolbar. To the left is an explorer to browse address lists and public folders, 
as well as your own favorites. To the right is the graphical free/busy view and, under it, the 
calendar view. At the bottom, you find the status line, which shows progress of operations 
as well as status information. 
When you start LOOK for the first time both views to the right are empty. The explorer 
shows Favorites, Address lists and Public Folders. The Favorites folder is empty to start with. 
By double-clicking Address lists, you will see a list of the address books that are available in 
your system. By double-clicking an address book, for example the Global Address List, you 
will see all members of it, i.e. the groups and users and/or resources that are members of 
the list. 
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To update the graphical free/busy view for a user or a group, you can, for example, select 
the user or group in the explorer and select Update Scheduler View from the Actions menu. 
You can also right-click on the user or group to perform this operation. 
To view the detailed calendar of for user or a group of users, select the user or group and 
then select Update Calendar View. You can also right-click on the user or group to perform 
this operation. 
LOOK also offers drag-and-drop so you can also drag a user or group from the explorer 
and drop it on the view you wish to update. 

 
There are many other actions that can be performed. Try right-clicking a user or a group 
and select some of the other actions. Also note that most actions are available as buttons 
on the toolbar. By letting the mouse pointer rest on top of a button, you will see a tool tip 
that explains what the button does. 
You can select several items in the explorer by using the Ctrl key and the Shift key, and then 
perform the action you want, exactly like when you need to select multiple items in a list or 
file dialog in other Windows applications. 
Just updating the views from the explorer, you will already now have noticed the immediate 
and most important benefit of LOOK. 
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Working with Favorites 
The users, resources and groups you use the most can be added to your favorites. You can 
also create your own private groups. 
You can add favorites in two different ways, by adding existing users, resources and groups 
to your favorites, or by creating your own private groups. 
To add an existing user, resource or group to favorites, select it in the explorer and select 
Add to Favorites from the Favorites menu. You can also right-click on the user, resource or 
group and select Add to Favorites. 
Another way to add existing users, resources and groups is to select Add from Address Book 
from the Favorites menu. This will open the LOOK Add to Favorites dialog as shown below, 
from which you can select all the users, resources and groups to add to your favorites. 

 

Creating Private Groups 
To create a new group, which will then become your own private group, select Create new 
Group from the Favorites menu. This will allow you to give the new group a name and add 
or remove members, as illustrated below. 

Using the Scheduler View 
The graphical free/busy view, called the scheduler view, in LOOK is similar to the Meeting 
Planner in Outlook. LOOK uses the same colors for the types of appointments (Tentative, 
Busy and Out of office). Appointments marked as Free are not shown. 
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You update the scheduler view by selecting users, resources and groups in the explorer and 
then selecting Update Scheduler View in the Actions menu. You can also just drag-and-drop 
items from the explorer to the scheduler view. 

 
By clicking on a schedule, the details of the underlying appointment are shown in a tool tip. 
LOOK shows not only the start time, end time and subject, but also other appointment 
information such as location, category and recurrence pattern when they apply. 
By moving the mouse over an appointment tool tip, it is highlighted, and you can click it to 
open the appointment in a standard Outlook Appointment form. 
Both of the above functions are accessible only when you have at least read permission on 
the calendar that contains the appointment. If you have write permission, you can even 
make and save changes to an appointment after opening it. 
Three different scheduler views are available; the daily view, the weekly view, and the monthly 
view. The weekly view shows more information (more days) at a time than the daily view, 
and the monthly view again shows more information that the weekly view. In other words, 
you can zoom in and out in three levels. 
By default the scheduler view shows free/busy information from the current date and a 
number of days ahead. You can make another date the starting date by selecting Scheduler 
View Go to Date in the Actions menu. 
You can refresh the scheduler view for the already shown users and/or resources by 
selecting Refresh Scheduler View in the View menu. The view will be updated with any 
changes that may have occurred to each calendar since the last update of the view. 
Many other features are available from the scheduler view: 
By double-clicking on a user or resource name in the scheduler view, the calendar view will 
be updated with the appointments for the user or resource. This is a quicker way to see the 
details of all the appointments of the user than clicking on each schedule one at a time. 
By double-clicking on a date, the calendar view will be updated with the appointments on 
that date for the users/resources shown in the scheduler view. This is a quicker way to see 
the details of all the appointments of the users/resources on that date than clicking on each 
schedule one at a time. 
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By right-clicking on a column corresponding to a time on a certain date, you can select the 
function Plan a Meeting which will allow you to select some of or all of the users/resources 
shown and then to plan a meeting with start date and time and attendees already inserted. 
Other functions are also available by right-clicking on the scheduler view, such as Send Mail, 
Open Calendar and Assign Task. 
The scheduler view can be toggled on and off from the View menu. By toggling it off, there 
will be more room for the calendar view. 

Using the Calendar View 
The calendar view shows the calendar for a user, resource or a group. You can update the 
calendar view by selecting the user or group in the explorer and select Update Calendar View 
from the Actions menu. You can also drag-and-drop the user or group from the explorer to 
the calendar view. 
There are three types of calendar views available; the list view, the week view and the month 
view. They all show appointment details if you have at least read permission to calendars. 
Otherwise, they will show free/busy information. 
The list view lists appointments as a simple list. When updated for a user or resource, the 
view lists appointments day by day. When updated for a group, the view lists appointments 
for each user one day at a time. 
Updating the list view with a user or resource, any active appointments (appointments that 
start before and end after the current date and time) are shown with a yellow background. 
Further, if there are any active appointments, the top row will show not only the name of 
the user or resource, but also the currently active appointment that has the latest end date 
and/or time. This makes it quick and easy to see when the user or resource will be back or 
available. An example of a calendar list view for a user is shown below. 

 
Updating the list view with a group looks like shown in the example below. The view lists 
appointments for each user one day at a time. 
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The week and month calendar view resembles the week and month calendar views in Outlook. 
An example of the calendar month view for a user is shown below. 

 
Moving the mouse pointer over an appointment in the week or month view, the full details 
for that appointment are shown. If there are more appointments on a day than LOOK can 
show, it is shown with a little yellow arrow. Double-clicking on a date in the view, or on the 
little yellow arrow when present, zooms in on the day to show all appointments and 
appointment details on that date. 
In all the calendar views, you can double-click any appointment to open it in a standard 
Outlook Appointment form. This requires read permission to the calendar containing the 
appointment. If you have write permission to the calendar containing the appointment, you 
can make and save changes to an appointment after opening it. 
A number of other functions are available by right-clicking on a day or appointment in the 
calendar view. 
By default the calendar view shows calendars from the current date and a number of days 
ahead. You can make another date the starting date for the view, by selecting Calendar View 
Go to Date in the Actions menu. Selecting this menu opens a calendar from which any date 
can be selected. 
You can refresh the calendar view for the already shown users by selecting Refresh Calendar 
View in the View menu. The view will be updated with any changes that may have occurred 
to each calendar since the last update of the view. 
The calendar view can be toggled on and off from the View menu. By toggling it off, there 
will be more room for the scheduler view. 
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Finally, note that the calendar view only shows appointment information when you have at 
least read permission to the calendars you want to view. Without read permission, LOOK 
will show free/busy information. 

Printing Views 
You can print both the scheduler view and the calendar view to any printer of your choice. 
LOOK will print in color if the selected printer supports it. 
By default, LOOK prints the complete view, but selecting Print Setup from the File menu 
allows you to specify whether to print complete views or a specific number of days ahead 
(or if you want LOOK to ask for this information when printing). The Print Setup dialog 
also allows you to specify default margins and default print orientation for the scheduler 
view and the calendar view respectively. 
To print the scheduler view, choose Print Scheduler View from the File menu. To print the 
calendar view, choose Print Calendar View from the File menu. 

Other Features 
LOOK provides other functionality for, for example, sending a message or a task to a user 
or group in the explorer and from the views. By right-clicking on a user’s name anywhere 
in the LOOK window, or on a user or group in the explorer, you can choose one of these 
functions. 
You can also, for example, arrange a meeting with a group. Select a group and the function 
Plan a Meeting. Note that LOOK gives you the possibility to select individual members of 
the group to be invited as attendees contrary to the Meeting Planner in Outlook. You can 
also plan a meeting by updating the scheduler view, finding a time, right-click and select 
Plan a Meeting. 
Finally, you can copy data from views in LOOK to the Windows Clipboard, Microsoft 
Word and Microsoft Excel. These functions are available through the File menu. 

About Free/Busy Information 
To get the full benefit of the LOOK scheduler view, there are a few extra things that are 
good to know. With LOOK, you can actually update the scheduler view with two different 
types of information from the server. One is the so-called free/busy information and the other 
is actual calendar information. The difference between the two is described below. This 
section will also explain a few other important things to know about the scheduler view. 

Note  If you use LOOK with the Symprex Exchange Connector (Real-Time Service), LOOK always 
uses calendar information and there is no delay in the data you see in LOOK. Using LOOK with 
Symprex Exchange Connector offers real-time views and very fast view updates. 

Updating the view with free/busy information is the fastest method and the method you will 
normally use. It provides a slightly delayed picture of each calendar – there can be a delay 
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between changes in a calendar and the change appearing in the view. This method uses the 
same data as Outlook itself uses in the Meeting Planner. 
Updating the view with calendar information is a slower method as LOOK tries to open each 
calendar to read the appointments in it. It is slower and it requires at least read permission 
to each calendar. It does, however, provide an exact picture of each calendar. If you use 
this type of update and LOOK cannot open a given calendar, free/busy information is 
shown instead. 
The scheduler view is updated with free/busy information by choosing Update Scheduler 
View and with calendar information by choosing Update Scheduler View (Calendar) in the 
Actions menu. 
How long the delay is before a change in a calendar appears in the scheduler view, when 
updating with free/busy information, depends on the environment in which, you are using 
LOOK. It is typically between a few minutes. 
If you find that you often, or for some reason always, need to update the scheduler view 
with calendar information, it is recommended to limit the number of days shown in the view 
as much as possible. The number of days shown can be configured in the LOOK Options 
dialog. 
When you move to another start date for the scheduler view (selecting Scheduler View Go to 
Date from the Actions menu), LOOK usually has to switch to use calendar information, 
even if you selected update using free/busy information. This is because the free/busy 
information available from the server is limited to a certain period of time. 
 



 

 

2 
Advanced Features 

This chapter explains the features available in the Advanced menu when having selected one 
or more users, resources or groups. These features are Find Appointments, Check Availability, 
Find Available Time, Show Appointment Conflicts and Export to HTML. 

Find Appointments 
LOOK enables you to search for appointments in multiple calendars in one single action. 
Simply select the users, resources and groups you want to include in the search and select 
Find Appointments from the Actions menu. 

 
An example of the Find Appointments dialog is shown below. Pick the start and end date for 
your search, specify the search criterias, press Find and you will get a list of all the matching 
appointments that is found. 
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Check Availability 
It is easy check the availability of users and resources with LOOK. Simply select the users, 
resources and groups you want to include and select Check Availability from the Actions 
menu. This will open the Check Availability dialog as illustrated below. 

 
Pick the start time and end time of the period to check availability for and press Check and 
LOOK will tell you if the selected users and/or resources are available. If they are, you can 
press Plan Meeting and LOOK will open a new Outlook meeting with the specified start and 
end time inserted and with the users/resources as attendees. 
If necessary, you can specify whether to accept conflicting appointments, not to accept 
conflicting appointments or that there must be a certain period of time available before 
and/or after the start time and end time. Accepting conflicting appointments will return 
available, even if there are conflicting appointments, but not if any of them are marked as 
Out of office. 
You can also specify if LOOK should check for availability using free/busy information or 
calendar information. Free/busy information is the same information as Microsoft Outlook 
shows in its Meeting Planner. It is the fastest method and does not require read permission 
on calendars; however, it gives a slightly delayed picture of each calendar. 
Using calendar information means that LOOK will try to open each calendar and check for 
availability. This is slower and requires read permission on each calendar. If LOOK cannot 
open a given calendar it uses the corresponding free/busy information instead. 
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Find Available Time 
To find available time for users and/or resources, for example for a meeting, just select the 
users, resources and groups to include and select Find Available Time from the Actions menu. 
This will open the Find Available Time dialog as illustrated below. 

 
Specify the duration of the available time to find, between what dates and what time of day 
to search, and what week days to search, then press Find, and LOOK will provide you with 
the first available time it finds. If the time is acceptable and you need to plan a meeting, you 
can proceed directly to a new Outlook meeting with the start and end time inserted and 
with the users/resources as attendees. Pressing Find & Plan Meeting instead of Find does all 
this automatically. 
If you press Find All, LOOK will show all possible available times found, as illustrated in 
the example below. Choose a time from the list, press Plan Meeting and LOOK will open a 
new Outlook meeting with the start and end time inserted and with the users/resources as 
attendees. 
The Options and Method settings have the same meaning as in the Check Availability dialog. 
If necessary, you can specify whether to accept conflicting appointments, not to accept 
conflicting appointments or that there must be a certain period of time available before 
and/or after the start time and end time. Accepting conflicting appointments will return 
available, even if there are conflicting appointments, but not if any of them are marked as 
Out of office. 
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You can also specify if LOOK should check for availability using free/busy information or 
calendar information. Free/busy information is the same information as Microsoft Outlook 
shows in its Meeting Planner. It is the fastest method and does not require read permission 
on calendars; however, it gives a slightly delayed picture of each calendar. 
Using calendar information means that LOOK will try to open each calendar and check for 
availability. This is slower and requires read permission on each calendar. If LOOK cannot 
open a given calendar it uses the corresponding free/busy information instead. 

Show Appointment Conflicts 
Because Microsoft Outlook does not prevent appointment conflicts, or appointments that 
overlap, it is often useful to be able to find such appointment conflicts and to resolve them. 
You can use LOOK for this purpose. Select the users, resources and groups to include and 
select Show Appointment Conflicts from the Actions menu. 

 
Specify the number of days ahead to check, press Check, and LOOK will show you a list of 
all found appointment conflicts by user and/or resource. You can then resolve the conflicts 
by opening appointments and changing them. 
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Checking for conflicts requires you to have at least read permission to calendars. Resolving 
conflicts also requires you to have at least write permission. 
You can optionally specify to ignore All Day Events, appointments marked as Out of office 
and/or appointments marked as Tentative. 

Export to HTML 
LOOK enables you to export calendars to an Internet or Intranet server as HTML 
documents. Select the users, resources and groups to export and select Export to HTML 
from the Actions menu, LOOK will open a dialog as shown in the example below. 

 
Specify the start date, the number of days to export, the view type you wish to export, a 
title for the HTML document and a destination file, and you can export by clicking Export. 
 





 

 

3 
Using Categories 

If you are using Outlook categories with appointments in your Outlook installation you can 
get LOOK to color-code appointments based on categories. This chapter explains how. 

How to Assign Category Colors 
To assign colors to categories, you need to open the Categories dialog by selecting Categories 
from the Tools menu. Unless category colors have already been defined, the dialog will open 
as shown in the example below. 

 
The option Use category colors must be checked to activate the use of category coloring, and 
before you can change any settings in the Categories dialog. 
The Use Outlook category colors option is available if you are using LOOK with Outlook 2007 
or 2010. When you select this option, LOOK will use the categories and colors defined in 
Outlook, and the buttons to change category colors will be disabled. 
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The final option Update free/busy view with calendar information by default is described in the 
following section below. 
If you have not selected the option to use Outlook category colors (which is only available 
when you use LOOK with Outlook 2007 or 2010), you can specify the category colors you 
want to use. 
By selecting a category you can define its color. Assign a color by pressing Set Color, or 
assign the standard color of one of the appointment types (Tentative, Busy or Out of office). 
You can remove an assigned color by pressing Free/Busy. Categories that have not been 
assigned a color are shown with a small black line. 
An example where colors have been assigned to a number of categories and where the use 
of category colors has been enabled is shown below. 

 
Appointments with no category, or a category that has not been assigned a color, are 
shown in the views using the color that corresponds to its type (Tentative, Busy or Out of 
office). 

Additional Information 
Since free/busy information does not contain any category information, you must update 
the scheduler view with calendar information to see appointments with the category colors 
you have specified. 
The scheduler view is updated with free/busy information when selecting the function 
Update Scheduler View and with calendar information by selecting the alternative function 
Update Scheduler View (Calendar) from the Actions menu. 
You can check the Update free/busy view with calendar information by default to change the two 
functions around so that Update Scheduler View updates the view with calendar information 
and Update Scheduler view (Calendar) becomes Update Scheduler view (Free/Busy) and updates the 
view with free/busy information. 
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Using category colors requires LOOK to read calendar information and it requires you to 
have at least read access to calendars. If LOOK cannot open a given calendar, it reads the 
free/busy information instead and the calendar will not be shown using category colors. 
 





 

 

4 
Other Features 

Using Filters 
LOOK allows you to define filters that you can apply at any time to view appointments 
that conform to a specific set of criterias; for example to view only appointments that have 
the category Holiday. 
You can define as many filters as you wish. To define new filters, or edit or delete existing 
filters, you must open the Filters dialog, shown in the example below, selecting Filters from 
the Tools menu. 

 
You can apply a filter (or remove an active filter) using the filter button on the toolbar or 
via the Filters menu in the Actions menu. 
If LOOK cannot not open a given calendar and shows the free/busy information for that 
calendar instead, or if the scheduler view is updated with free/busy information, the filter 
will remain selected, but all appointments will be shown as the filter cannot be applied 
because LOOK cannot filter on free/busy information. 
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Enabling User Colors 
When the calendar view in LOOK is in week or month mode the space for appointments 
details in the actual view are limited. This is especially true when the view is updated for a 
group or several selected users and/or resources because LOOK must then also show the 
user or resource name in front of each appointment. LOOK therefore allows you to define 
a color to use for the calendars you view the most. 
If you define a color for a user or resource, appointments belonging to the user or resource 
are colored in that color when the calendar view is updated and is in week or month mode, 
and when the user or resource name is not shown allowing more space for appointment 
details. You can define user colors by selecting User Colors from the Tools menu. This will 
open the User Colors dialog, which is shown in the example below. 

 

Using Quick Search 
LOOK provides a quick search feature in the form of a Search textbox that can be used for 
updating the calendar or scheduler view. By entering the alias of a user or resource and 
pressing Enter, the calendar view is updated for that user or resource. Pressing Shift+Enter 
updates the scheduler view. 
The alias is the mailbox name of the user or resource. You can find the alias of a user or 
resource by selecting it in the address books or in your favorites and selecting Properties 
from the Actions menu. 
 



 

 

5 
Options and Settings 

There are a number settings in LOOK that can be used to configure it to your preferences. 
These settings can be changed by selecting Options from the Tools menu. The Options dialog 
contains seven tabs: General, Explorer, Scheduler, Calendar, Startup, Other and Advanced. 
Note that you can restore the original settings at any time by selecting Set Installation Defaults 
in the Tools menu. 

General Settings 
The General settings tab in the Options dialog is shown below: 
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The settings are explained in the table below: 

Setting Description 

Calendar work week Weekdays to show in views, and workday start and end 
time. The default is to show Monday to Friday and 8 to 
18. 

Time format Time format to be used. The default is to use Windows 
settings time format. 

User interface style User interface style to be used. Default is Outlook 2003 
style. 

User interface language Language to be used. The default is to use the Windows 
locale language if available in LOOK. 

Explorer Settings 
The Explorer settings tab in the Options dialog is shown below: 

 
The settings are explained in the table below: 

Setting Description 

Show names by Show users in the explorer sorted by display name, first 
name or last name. Default is display name. 

Include information Additional information to show for users in the explorer, 
such as title, office, and phone number. 



  Options and Settings 31 
 

Setting Description 

Include members of sub-
groups in groups 

Include all members of any selected groups, including 
any members in any sub-groups. Default is on (selected). 

Do not include members of 
sub-groups in groups for 
address lists 

If an address book is selected, do not include members of 
any sub-groups of groups that are immediate members of 
the address book. Default is on (selected). 

Scheduler Settings 
The Scheduler settings tab in the Options dialog is shown below: 

 
The settings are explained in the table below: 

Setting Description 

Days to look ahead Number of days to show in the scheduler view. Default is 
30 days. 

Update every minutes Refresh the scheduler view every specified number of 
minutes. Default is off. 

Hide rows with no schedules Hide rows in the scheduler view with no schedules. 
Default is off. 

Hide rows with no available 
data 

Hide rows in the scheduler view with no available data. 
Default is off. 
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Setting Description 

Scheduler details Details to include in tool tips in the scheduler view. 
Default is appointment categories, recurrent patterns and 
meeting organizer. 

Calendar Settings 
The Calendar settings tab in the Options dialog is shown below: 

 
The settings are explained in the table below: 

Setting Description 

Days to look ahead Number of days to show in the calendar view. Default is 
30 days. 

Calendar details Appointment details to include in the calendar view. The 
default is appointment categories, recurrent patterns and 
meeting organizer. 

Show start and end time 
instead of just start time 

In the calendar week and month view, show start and end 
time instead of just start time. Default is off. 

Show full display names 
instead of just alias 

In the calendar week and month view, show full display 
names instead of just alias. Default is off. 
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Startup Settings 
The Startup settings tab in the Options dialog is shown below for the true Outlook add-in 
version of LOOK: 

 
The Startup settings tab in the Options dialog is shown below for the stand-alone version of 
LOOK: 
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The settings are explained in the table below: 

Setting Description 

Update scheduler view from 
last session 

Update the scheduler view with the overview from the 
previous session. Default is on. 

Update calendar view from 
last session 

Update the calendar view with the overview from the 
previous session. Default is off. 

Disable splash screen Disable the splash screen. Default is off. 

Profile (stand-alone version 
of LOOK) 

Optionally specify the profile that LOOK should use on 
startup if Outlook is not running. 

Replace Outlook Schedules 
(add-in version of LOOK) 

Replace Outlook 2002/2003/2007/2010 Schedules 
view with LOOK. Default is on. 

Other Settings 
The Other settings tab in the Options dialog is shown below: 

 
The settings are explained in the table below: 

Setting Description 

Invite attendees default Invite attendees default in LOOK Plan Meeting dialog. 
Default is on. 
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Setting Description 

Select attendees default Select all attendees default in LOOK Plan Meeting dialog. 
Default is on. 

Auto-prefix search criterias 
with ‘=’ 

Auto-prefix search criterias with ‘=’ during quick search. 
Default is on (should be left on). 

Enable extended quick 
search 

Enable extended quick search. LOOK will load the entire 
Global Address List on start-up (this can take time in 
large installations) to enhance the quick search feature 
with a drop-down list. When enabled, the loading of the 
Global Address List can be interrupted during start-up by 
holding down the Shift key. Default is off. 

Hot key activate Global hot key that will activate LOOK from anywhere in 
Windows (LOOK must be running). Default is Ctrl+F12. 

Show private appointments Show private appointments. Default is off. 
Note  your own private appointments will always show. 

Advanced Settings 
The Advanced settings tab in the Options dialog is shown below: 
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The settings are explained in the table below: 

Setting Description 

Use Symprex Exchange 
Connector database 

Enable to use Symprex Exchange Connector (Real-Time 
Service) database. Default is off. 

Database type Database type. Can be MS SQL Server / MSDE or Access. 

Database If the database type is SQL Server, specify the name of 
the database. If the database type is Access, specify the 
full qualified file name of the database. 

SQL Server If the database type is SQL Server, specify the name of 
the server. 

User ID If the database type is SQL Server, specify the user name 
to use when logging on to the database. 

Password If the database type is SQL Server, specify the password 
to use when logging on to the database. If the database 
type is Access and the database is password enabled, 
specify the database password. 

Click the Test connection button to test the connection when you have specified the required 
settings. 
You can find information about the Symprex Exchange Connector (Real-Time Service) on 
Symprex.com. You are of course also welcome to contact Symprex for more information. 
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A 
End-User License Agreement 

IMPORTANT-READ CAREFULLY: This Symprex End-User License Agreement ("EULA") is a legal agreement between 
you (either an individual or a single entity) and Symprex Limited for the Symprex software product identified above, 
which includes computer software and may include associated media, printed materials, and "online" or electronic 
documentation ("SOFTWARE PRODUCT"). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you 
agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or use the 
SOFTWARE PRODUCT. 

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other 
intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 

1. GRANT OF LICENSE. 

This EULA grants you the following rights provided that you comply with all terms and conditions of this EULA: 

* Applications Software. You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the 
same operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT 
is installed may make a second copy for his or her exclusive use on a portable computer. 

* Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such 
as a network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal 
network; however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE 
PRODUCT is installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be shared or 
used concurrently on different computers. 

* License Pak. If you have acquired this EULA in a Symprex License Pak, you may make the number of additional 
copies of the computer software portion of the SOFTWARE PRODUCT authorized on the printed copy of this EULA, and 
you may use each copy in the manner specified above. You are also entitled to make a corresponding number of 
secondary copies for portable computer use as specified above. 

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 

* Evaluation Software. If the SOFTWARE PRODUCT is labeled "Evaluation Version" or "EV", then, notwithstanding 
Section 1 of this EULA, your use of the SOFTWARE PRODUCT is limited to use for demonstration, test, or evaluation 
purposes for a limited period of time governed by the evaluation license and you may not resell, or otherwise transfer for 
value, the SOFTWARE PRODUCT. 

* Academic Edition Software. If the SOFTWARE PRODUCT is identified as "Academic Edition" or "AE," you must be a 
"Qualified Educational User" to use the SOFTWARE PRODUCT. If you are not a Qualified Educational User, you have 
no rights under this EULA. To determine whether you are a Qualified Educational User, please contact Symprex Limited. 

* Not for Resale Software. If the SOFTWARE PRODUCT is labeled "Not for Resale" or "NFR," then, notwithstanding 
other sections of this EULA, you may not resell, or otherwise transfer for value, the SOFTWARE PRODUCT. 

* Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or 
disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by 
applicable law notwithstanding this limitation. 
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* Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not 
be separated for use on more than one computer. 

* Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT.  

* Support Services. Symprex may provide you with support services related to the SOFTWARE PRODUCT ("Support 
Services"). Use of Support Services is governed by the Symprex policies and programs described in the user manual, in 
"online" documentation, and/or in other Symprex-provided materials. Any supplemental software code provided to you 
as part of the Support Services shall be considered part of the SOFTWARE PRODUCT and subject to the terms and 
conditions of this EULA. With respect to technical information you provide to Symprex as part of the Support Services, 
Symprex may use such information for its business purposes, including for product support and development. Symprex 
will not utilize such technical information in a form that personally identifies you. 

* Software Transfer. You may permanently transfer all of your rights under this EULA, provided you retain no copies, you 
transfer all of the SOFTWARE PRODUCT (including all component parts, the media and printed materials, any 
upgrades, this EULA, and, if applicable, the Certificate of Authenticity), and the recipient agrees to the terms of this 
EULA. If the SOFTWARE PRODUCT is an upgrade, any transfer must include all prior versions of the SOFTWARE 
PRODUCT. 

* Termination. Without prejudice to any other rights, Symprex may terminate this EULA if you fail to comply with the 
terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of 
its component parts. 

3. UPGRADES. 

If the SOFTWARE PRODUCT is labeled as an upgrade, you must be properly licensed to use a product identified by 
Symprex as being eligible for the upgrade in order to use the SOFTWARE PRODUCT. A SOFTWARE PRODUCT 
labeled as an upgrade replaces and/or supplements the product that formed the basis for your eligibility for the upgrade. 
You may use the resulting upgraded product only in accordance with the terms of this EULA. If the SOFTWARE 
PRODUCT is an upgrade of a component of a package of software programs that you licensed as a single product, the 
SOFTWARE PRODUCT may be used and transferred only as part of that single product package and may not be 
separated for use on more than one computer. 

4. COPYRIGHT. 

All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, 
animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE PRODUCT), the accompanying 
printed materials, and any copies of the SOFTWARE PRODUCT are owned by Symprex or its suppliers. The 
SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions. Therefore, you must treat the 
SOFTWARE PRODUCT like any other copyrighted material except that you may install the SOFTWARE PRODUCT on 
a single computer provided you keep the original solely for backup or archival purposes. You may not copy the printed 
materials accompanying the SOFTWARE PRODUCT. 

5. DUAL-MEDIA SOFTWARE. 

You may receive the SOFTWARE PRODUCT in more than one medium. Regardless of the type or size of medium you 
receive, you may use only one medium that is appropriate for your single computer. You may not use or install the other 
medium on another computer. You may not loan, rent, lease, or otherwise transfer the other medium to another user, 
except as part of the permanent transfer (as provided above) of the SOFTWARE PRODUCT. 

6. LIMITED WARRANTY. 

Symprex warrants that the SOFTWARE PRODUCT will perform substantially in accordance with the accompanying 
written materials for a period of ninety (90) days from the date of receipt. If an implied warranty or condition is created by 
your state/jurisdiction and federal or state/provincial law prohibits disclaimer of it, you also have an implied warranty or 
condition, BUT ONLY AS TO DEFECTS DISCOVERED DURING THE PERIOD OF THIS LIMITED WARRANTY 
(NINETY (90) DAYS). AS TO ANY DEFECTS DISCOVERED AFTER THE NINETY (90) DAY PERIOD, THERE IS NO 
WARRANTY OR CONDITION OF ANY KIND. Some states/jurisdictions do not allow limitations on how long an implied 
warranty or condition lasts, so the above limitation may not apply to you. Any supplements or updates to the 
SOFTWARE PRODUCT, including without limitation, any (if any) service pack or hot fixes provided to you after the 
expiration of the ninety (90) day Limited Warranty period are not covered by any warranty or condition, express or 
implied. 

LIMITATION ON REMEDIES; NO CONSEQUENTIAL OR OTHER DAMAGES. 

Your exclusive remedy for any breach of this Limited Warranty is as set forth below. Except for any refund elected by 
Symprex, YOU ARE NOT ENTITLED TO ANY DAMAGES, INCLUDING BUT NOT LIMITED TO CONSEQUENTIAL 
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DAMAGES, if the SOFTWARE PRODUCT does not meet Symprex's Limited Warranty, and, to the maximum extent 
allowed by applicable law, even if any remedy fails of its essential purpose. The terms of Paragraph 8 below ("Exclusion 
of Incidental, Consequential and Certain Other Damages") are also incorporated into this Limited Warranty. Some 
states/jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above 
limitation or exclusion may not apply to you. This Limited Warranty gives you specific legal rights. You may have others 
which vary from state/jurisdiction to state/jurisdiction. 

YOUR EXCLUSIVE REMEDY. 

Symprex's and its suppliers' entire liability and your exclusive remedy shall be, at Symprex's option from time to time, (a) 
return of the price paid (if any) for, or (b) repair or replacement of, the SOFTWARE PRODUCT that does not meet this 
Limited Warranty and that is returned to Symprex with a copy of your receipt. You will receive the remedy elected by 
Symprex without charge, except that you are responsible for any expenses you may incur (e.g. cost of shipping the 
SOFTWARE PRODUCT to Symprex). This Limited Warranty is void if failure of the SOFTWARE PRODUCT has 
resulted from accident, abuse, misapplication, abnormal use or a virus. Any replacement SOFTWARE PRODUCT will 
be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. Neither these 
remedies nor any product support services offered by Symprex are available without proof of purchase from Symprex or 
an authorized international source. To exercise your remedy, contact Symprex Limited. 

7. DISCLAIMER OF WARRANTIES. 

The Limited Warranty that appears above is the only express warranty made to you and is provided in lieu of any other 
express warranties (if any) created by any documentation or packaging. Except for the Limited Warranty and to the 
maximum extent permitted by applicable law, Symprex and its suppliers provide the SOFTWARE PRODUCT and 
Support Services (if any) AS IS AND WITH ALL FAULTS, and hereby disclaim all other warranties and conditions, either 
express, implied or statutory, including, but not limited to, any (if any) implied warranties or conditions of merchantability, 
of fitness for a particular purpose, of lack of viruses, of accuracy or completeness of responses, of results, and of lack of 
negligence or lack of workmanlike effort, all with regard to the SOFTWARE PRODUCT, and the provision of or failure to 
provide Support Services. ALSO, THERE IS NO WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, 
QUIET POSSESSION, CORRESPONDENCE TO DESCRIPTION OR NON-INFRINGEMENT WITH REGARD TO THE 
SOFTWARE PRODUCT. 

IF YOU ACQUIRED THE SOFTWARE PRODUCT VIA WEB DOWNLOAD, THE FOLLOWING WARRANTY 
EXCLUSION APPLIES TO YOU: 

NO WARRANTIES. Symprex expressly disclaims any warranty for the SOFTWARE PRODUCT.  THE SOFTWARE 
PRODUCT AND ANY RELATED DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY OR CONDITION 
OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
AND CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT.  
THE ENTIRE RISK ARISING OUT OF USE OR PERFORMANCE OF THE SOFTWARE PRODUCT REMAINS WITH 
YOU. 

8. EXCLUSION OF INCIDENTAL, CONSEQUENTIAL AND CERTAIN OTHER DAMAGES. 

To the maximum extent permitted by applicable law, in no event shall Symprex or its suppliers be liable for any special, 
incidental, indirect, or consequential damages whatsoever (including, but not limited to, damages for loss of profits or 
confidential or other information, for business interruption, for personal injury, for loss of privacy, for failure to meet any 
duty including of good faith or of reasonable care, for negligence, and for any other pecuniary or other loss whatsoever) 
arising out of or in any way related to the use of or inability to use the SOFTWARE PRODUCT, the provision of or failure 
to provide Support Services, or otherwise under or in connection with any provision of this EULA, even if Symprex or 
any supplier has been advised of the possibility of such damages. 

9. LIMITATION OF LIABILITY AND REMEDIES. 

Notwithstanding any damages that you might incur for any reason whatsoever (including, without limitation, all damages 
referenced above and all direct or general damages), the entire liability of Symprex and any of its suppliers under any 
provision of this EULA and your exclusive remedy for all of the foregoing (except for any remedy of repair or 
replacement elected by Symprex with respect to any breach of the Limited Warranty) shall be limited to the greater of 
the amount actually paid by you for the SOFTWARE PRODUCT or US$5.00. The foregoing limitations, exclusions and 
disclaimers (including Sections 6, 7 and 8 above) shall apply to the maximum extent permitted by applicable law, even if 
any remedy fails its essential purpose. 

10. NOTE ON USAGE. 

THE SOFTWARE PRODUCT CONTAINS CODE WRITTEN IN VISUAL BASIC, VBSCRIPT AND JAVA 
("PROGRAMMING LANGUAGES"). THESE PROGRAMMING LANGUAGES ARE NOT FAULT TOLERANT AND ARE 
NOT DESIGNED, MANUFACTURED, OR INTENDED FOR USE OR RESALE AS ONLINE CONTROL EQUIPMENT IN 
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HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, SUCH AS IN THE OPERATION OF 
NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, 
DIRECT LIFE SUPPORT MACHINES, OR WEAPONS SYSTEMS, IN WHICH THE FAILURE OF VISUAL BASIC, 
VBSCRIPT OR JAVA TECHNOLOGY COULD LEAD DIRECTLY TO DEATH, PERSONAL INJURY, OR SEVERE 
PHYSICAL OR ENVIRONMENTAL DAMAGE. 

11. APPLICABLE LAW. 

This EULA is governed by the laws of the United Kingdom. 

12. ENTIRE AGREEMENT. 

This EULA (including any addendum or amendment to this EULA which is included with the SOFTWARE PRODUCT) 
and the Client Access License (if applicable) are the entire agreement between you and Symprex relating to the 
SOFTWARE PRODUCT and the Support Services (if any) and they supersede all prior or contemporaneous oral or 
written communications, proposals and representations with respect to the SOFTWARE PRODUCT or any other subject 
matter covered by this EULA. To the extent the terms of any Symprex policies or programs for Support Services conflict 
with the terms of this EULA, the terms of this EULA shall control. 

13. QUESTIONS? 

Should you have any questions concerning this EULA, please contact Symprex Limited. See http://www.symprex.com 
for contact information. 
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